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Downloading the program:  
 
Download FISH from the following web address: 
 
http://www.small-angle.ac.uk/small-angle/Software.html 
 
There are both PC and linux versions available.   
 
You will be asked to provide your name, institution and e-mail address (this is so 
we can tell you about updates as required and so we can tell our management 
about how popular our software is).   
 
Click the ‘Submit Download Request’ and you will then receive an e-mail 
containing a singe use weblink which you can follow to download FISH to your 
computer.  
 
The following instructions are for the PC version: 
 
Save the zip file on your computer and then extract the contents to an 
appropriate folder which, from now on, will be referred to as the FISH folder and 
the example used here is: 
 
C:\FISH 
 
Once extracted your FISH folder should contain four folders (bin, doc, lib, work) 
and two files (fish.exe and lsinp.dat).  In the doc folder you will find the FISH 
manual in pdf format and also some release notes (which tell you what system 
requirements and software you need to run FISH).  Contained in the work folder 
are some sample data files in various formats (you don’t need to worry about the 
other two folders, but make sure they are there!).  The file lsinp.dat contains 
many useful fitting models which are available to you when you use FISH. File 
fish.exe starts the program running, right click on it to make a short cut for your 
desk top. 
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Getting started: 
 
Double click on fish.exe and two windows should appear (be patient) as pictured 
below in Figure 1: 
 

 
Figure 1 
 
 
Click ‘Preferences’ and from the drop down menu chose ‘Preferences…’.  From 
here you can set your working directory (the default directory where FISH looks 
for data sets and saves output files too) and also your initial model file (the 
directory where FISH looks for model files).  It is usual to set the working 
directory to: 
 
C:\FISH 
 
but you are still given the option to look for data sets and save output files 
elsewhere as with most programs.  More importantly, set the ‘Initial model file’ to: 
 
C:\FISH\lsinp.dat 
 
so that FISH will automatically look in the correct place for the default model files. 
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Reading in a data set: 
 
To read in a data set select the ‘Data’ tab and click the ‘Add data file…’ button 
and select your file (the default directory will be C:\FISH if you have followed  the 
suggestions above but you can search elsewhere) and click ‘Add’.  The file with 
appear in the ‘Data’ tab, providing there are no errors in the file.  If there is more 
than one data set in the file, for example if you have linear and logarithmically 
binned data in the same file, two lines will appear (the order in which they appear 
depends on the order of the data in the file).  More data sets can be added if 
required (for example for the General Microemulsion model three sets are 
needed). 
 
FISH will read ASCII data files conforming to any of the following formats: 
CanSAS SASXML (v1.0), 3-column CSV (comma separated variable – additional 
columns are ignored, column headers are permitted), or the historic ISIS 
COLETTE program output. 
 
Once you’ve added all the files you require then select the data set which you 
would like to fit by ticking the box in the ‘Use’ column (as shown in Figure 2).  
Your data should appear in the plot window (red markers), along with a blue line 
which represents a calculated I(Q) for a selected model, a green line which 
represents the difference between the calculated I(Q) and the actual data i.e. the 
difference between the data and the fit to the data and a yellow line which is a 
constant and helps the user to see how the Obs – Calc parameter is changing as 
the fitting of the data progresses.   
 
Figure 2 shows six sets of data (from three files) displayed in the ‘Data’ tab.  In 
this example logarithmically binned data from the first data file has been selected 
for analysis with FISH (2nd row down) and has been given the label ‘Set 1’. 
 

 
Figure 2 
 
 
 



 4

Choosing a model: 
 
A model can now be chosen.  This is done by selecting the ‘Model’ tab and then 
clicking the left mouse button once on the model of choice.  When you click a 
model the blue in the plot window will change to the appropriate calculated I(Q) 
vs. Q for that model with standard values as  parameters (the green line will 
obviously alter too as the Obs – Calc value is also changing).  ‘Hovering’ the 
mouse pointer over a model will allow a brief description of the model file to be 
viewed as shown in Figure 3 (for more detail see the manual and the lsinp.dat 
file). 
 

 
 
Figure 3 
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Fitting the data:  
 
Parameters within a model file can be altered using the ‘Fitting’ tab.  Once this 
tab has been selected a list of the parameters (column 1) with values from the 
LSINP.DAT file (column 2) will be displayed (as shown in Figure 4, for the case 
of a core/shell cylinder model).  Change the values as required by double clicking 
on the actual value in column 2 and typing in a new number.   
 
As you change parameter values, the blue line will change to the new calculated 
I(Q) generated from the values being input into the system.  Parameters can 
either be allowed to float or remain fixed whilst fitting by selecting (or not 
selecting) the values in the ‘Fit’ column (column 4) (it is best not to let too many 
parameters float all in one go!).  In Figure 4 the SCALE, RADIUS(out), LENGTH 
and Flat Bkg parameters are all being allowed to adjust as the fit is progressed, 
but the other parameters are all held constant.  Pressing the ‘Run’ button starts 
one cycle of the fit routine. 
 
The default fit type used is determined by the control parameters in the model 
file, but is usually a Marquardt ‘steepest descent’. This is guaranteed to find a 
better fit, but will not explore a large region of parameter space, so can become 
stuck in a local minimum (see Appendix to FISH manual). Change to normal 
“least squares” by clicking ‘Fit’, choosing ‘Constants and Flags…’ from the drop 
down menu and then selecting the different fit type. The same menu enables you 
to re-set the Marquardt λ parameter to its starting value of 1.0. 
 
The ‘Run’ button can be pressed several times to continue cycling through the 
fitting routine and the calculated I(Q) will be updated with each cycle and 
displayed on the plot.  It is possible to go back a cycle by pressing the down 
arrow next to the cycle number (see Figure 4) or you can ‘turn back’ the fit cycle 
further by selecting a much lower cycle number. However, the more recent fits 
will be lost.   
 
The default statistical information shown on the ‘Fitting’ tab is the GOF 
(goodness of fit or χ2), λ (for the Marquardt algorithm) and the variance.  The 
actual values of XDWE and SWSE can be displayed by selecting ‘Show SWSE 
and XDWE’ from the ‘Preferences’ tab.   
 
For full information on the models please see the appropriate section in the FISH 
manual (it is worth noting that in FISH the units for length, radius etc is always Å 
and for scattering length density is 1010 cm-2 - so D2O has a value of 6.35). To 
find the “model number” that is referenced in the manual you may need to use 
the “preferences” drop down and check “show model numbers”. 
 
For more information on the statistics used in FISH please see Appendix E in the 
manual. 
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You can go forward/backward 
cycles by using these arrows

Number of cycles
 

Figure 4 
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Plotting: 
 
The plot of the fit automatically updates as cycles of the calculation are 
performed.  However, certain aspects of the plot can be altered as required: 
 
Zooming in or out of a plot.  Pressing the right mouse button anywhere on the 
plot will give a display as shown in Figure 5.  Using this box allows the user to 
zoom in or out of both axis or just the Domain Axis (X-axis) or Range Axis (Y-
axis).  Selecting ‘Auto Range’ will bring back the original display. 
 

 
Figure 5 
 
 
The data can be displayed on either linear (the default) or logarithmic axis by 
clicking the ‘Axis’ tab, choosing X-Axis or Y-axis and selecting either ‘Linear’ or 
‘Logarithmic’.  Once the new axis type has been chosen this can then be 
selected as the default display by once again clicking the ‘Axis’ tab and then 
selecting ‘Save As Defaults’. 
 
Extra variables can be displayed.  The default settings are to have Set 1 Obs 
(data for set 1), Set 1 calc (the calculated fit to the data for set 1), Set 1 obs – 
calc (the difference between the data and fit) and a constant (which makes it 
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clearer to see how the difference changes) displayed.  However, these can be 
deleted from the plot and/or  extra variables can be displayed, for example: 
  
P(Q)   (the form factor contribution to the fit)  
S(Q)   rescaled (the structure factor contribution to the fit)  
beta(Q)  rescaled (a ratio by which the structure factor has to be corrected 

when models for polydisperse or asymmetric particles are used) 
 
These can be displayed by clicking the ‘Series’ tab from the plot window and then 
selecting ‘Edit Series…’.  A box will pop up and from here variables can be 
added, edited or deleted (see Figure 6): 
 

Variables can be added, 
edited or deleted using these 
buttons

To edit or delete a variable 
the row must be selected 
(click left mouse button once 
on column) as shown here

 
Figure 6 
 
 
To add a variable click ‘Add’ and another box will appear (Figure 7).  Choose the 
required variable from the drop down menu and click ‘Ok’ to accept the changes. 
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Variable to be 
added/edited is 
chosen here

Data sets are added using 
this drop down menu

The label can be changed 
by un-ticking this box and 
typing in the new label 
here

Y-shift can be altered here

The data can be shown 
either as a line or a symbol 
by using these options and 
the Y-error bars can be 
shown as necessary

 
 
Figure 7 
 
To edit a variable highlight the variable which requires altering (as shown in 
Figure 6).  Then press ‘Edit’.  The box shown in Figure 7 will appear and the 
desired alterations can be made.  Again, click ‘Ok’ to accept changes. 
 
To delete a variable select the appropriate variable (again as in Figure 6) and 
press ‘Delete’.  Variables can be re-added if required! 
 
A plot title can be added and axis labels and ranges can be altered.  Select the 
‘Plot’ tab and then choose ‘Properties…’.  A box will appear as shown in Figure 
8. 
 



 10

 
 
Figure 8 
 
Type the title in the ‘Text:’ line and make sure the ‘Show Title:’ box is ticked.  The 
font and colour of the text can also be changed from here. 
 
Clicking on the ‘Plot’ tab shown in Figure 8 brings up the options as shown in 
Figure 9.  The label and range of both axes can be changed from this tab along 
with the appearance (font, colour, weight). 
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Change label, font 
and colour here

Change range using 
this tab

Change ‘Range Axis’ (Y-axis) 
parameters using this tab 

Change colour, weight and 
orientation of axis using this tab 

Change ‘Domain Axis’ (X-axis) 
parameters using this tab (as 
sleceted here) 

 
Figure 9 
 
Selecting the ‘Other’ tab shown in Figures 8 and 9 allows the background colour 
of the chart to be altered. 
 
The plot can be saved (as a picture not the data) and printed by clicking the ‘Plot’ 
tab and then selecting either ‘Save as…’ or ‘Print’, then follow the instructions, 
this can be quite slow to respond. 
 
Parameter table, time, date and legend can be added or removed from the plot 
window.  All these functions can be found by clicking the ‘Window’ tab.  Choosing 
‘Show Parameter Table’ will display the fit parameters on the top left hand side of 
the plot.  Opting for ‘Show Full Model Definition’ will display the fit parameters, 
standard deviation, whether or not a parameter was ‘switched on’ whilst fitting 
was taking place and the calculated shift on the top left hand side of the plot.  
Selecting ‘No Parameter Table’ will remove both of these options.  ‘Show Time 
and Date’ will display the time and date on the top right hand side of the fit and 
‘Show Legend’ displays the legend.  Once alterations to the window have been 
made then these settings can be saved as the default by choosing ‘Save As 
Defaults’ from the ‘Window’ tab.  
 
The plot routines make use of “jfreechart” from http://www.jfree.org/jfreechart/ 
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Saving data: 
 
Both the current fit and parameters (in model file format) can be saved.  To do 
this go to ‘File’ then either ‘Save data as…’ or ‘Save parameters as…’ to save 
either the fit or parameters as new files.  To append new data or parameters to 
an existing file then opt for ‘Save data’ or ‘Save parameters’.  Once ‘Save data 
as…’ has been selected you will be given the option to save a number of data 
sets (1 – 8 depending on how many sets you have been fitting) and also to save 
various data types: 
 

 

Figure 10 
 
If sets are unused then using the default settings (as shown in Figure 10) will 
only save sets which actually contain data. 
 
The five data types are: 
 
OBS  (the observed scattering i.e. your data)  
CALC  (the calculated fit) 
P(Q)  (the form factor contribution to the fit) 
S(Q)  (the structure factor contribution to the fit) 
beta(Q) (a ratio used in a correction to S(Q) for polydisperse or asymmetric 

particles – see manual) 
 
The default settings will only save the calculated data type (as in Figure 10). 
 
Currently, the data files are written out in the original ISIS Colette program output 
format (a 3 column space separated variable format with header).  These are 
easy to import into graphing packages. 



 13

Advanced stuff and helpful tips:  
 
If a model is expecting more than one data set, the order in which the check 
boxes in the “use” column of the data tab are checked is the order in which the 
FISH model expects them. e.g. for core, shell & drop contrasts, first un-check any 
checked boxes, then check the data set you need for the core, followed by the 
shell and then the drop contrast.  
 
To start a plot for the second and third data sets use the “plot” menu and select 
“new window”. The same command will also allow say both linear and log plots of 
a single data set on the screen simultaneously. 
 
Add “-console” to the short-cut you use to start FISH to see the Fortran output 
screen which contains useful diagnostics, especially if something is not working. 
(e.g. in the “target” box, “C:\fish\fish.exe -console”,   note the minus sign!) 
 
The present version of the new FISH does not allow constraints to be turned on 
or off. To get around this you have to copy and paste a separate model in 
LSINP.DAT with the alteration made.  
 
The default LSINP.DAT contains many useful models, however some more 
obscure models or particular combinations of model that you may need may not 
be there. It is quite easy, with help from the full reference manual, to edit the 
LSINP.DAT file to introduce them, but if you are unsure, please contact Richard 
Heenan for help. 
 
Note you can edit your own saved models back into LSINP.DAT or simply use a 
previously saved model file as a starting point for the next session. Opening a 
further model file with “add model file” appends the models in the new file to the 
end of the list in the models tab, so you may have to scroll down to find them. 
 
Models that require two or three dimensional numerical integration, such as 
core/shell cylinders oriented in shear flow are currently still only available in the 
old line-mode Fortran version of FISH. 

 


